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General Overview: 
 

Ostendo integration with Xero offers an automated approach to the posting process of financial 

entries. This means that depending upon your posting frequency setting, the financial transactions 

created in Ostendo will automatically be passed through to Xero at a minimum of 5-minute 

intervals. 

 

Integration with Xero is active when you see “Xero” displayed at the bottom status bar of the 

Ostendo main screen: 

 

  
 

This document describes three methods of configuring Xero / Ostendo. 

 

Why three methods? 

 

The method you choose depends upon the areas of Ostendo you wish to use. It is principally 

about whether you wish to manage your Accounts Receivable from within Ostendo or within Xero.  

 

In Ostendo, when setting up the connection to Xero, you will be prompted to log into Xero using 

your Xero Login email address. (Your user permission level must be at least Standard or Business 

Advisor). 

 

Decision Process: 
 

Overview: 
 

One of three methods must be adopted for the purposes of handling Accounts Receivable. Each 

method is appropriate under its own specific circumstances. 

 

It should be noted that none of these methods alter the way Ostendo passes Purchase Invoices to 

Xero. They are always passed in their most detailed form on an invoice-by-invoice and Line-by- 

Line basis.  

 

Please carefully read the explanation of all three methods to assist you in determining the best 

method to employ for your site. 
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Xero Limits: 
 

Please note that Xero has certain transaction limits. This link explains the current Xero Limits: 

  

https://developer.xero.com/documentation/oauth2/limits 

 

 We have done the following to minimize the chances of exceeding these limits: 

  

1. To reduce the number of calls we make to Xero when exporting customer and supplier 

records, we bundle 100 records at a time. However each request cannot exceed 3.5MB 

(size limit per call).  

 

2. The 1000 API calls limit is a “rolling 24 hour period”. So if API calls are spread out evenly 

then it would be less of an issue. We have provided in Systems Settings the function to set 

the frequency of posting. If you have high transaction volumes, you may need to set a 

more regular posting frequency (perhaps hourly or every 30 mins). 

 

You should also be familiar with Xero’s  SYSTEM LIMITS as described in the link above: 

 

a. Xero is designed for volumes of up to 1,000 Sales invoices (Accounts Receivables) and 

1,000 Purchases bills (Accounts Payables) per month, dependent also on the frequency of 

invoicing during the month, variability of amounts and the frequency of sales tax reporting 

requirements.  

b. Using Xero to handle Inventory of more than 1000 items may cause performance issues, 

therefore using Ostendo to handle inventory will minimise the transactions problems.  

c. Storing more than 5000 Contacts (suppliers + customers + employees) in Xero could also 

cause performance issues.  

 

 

 

There are also Pricing Plan limits – which determines the number of Invoices that can be 

processed by Xero in a month.

https://developer.xero.com/documentation/oauth2/limits
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Determining the Integration Method 
 

NB: Method 3 will be available Late 2021 
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Method 1 Explained: (Preferred Method) 
 

Uses both Xero and Ostendo Accounts Receivable Sub Ledgers 

 

This method allows you to process AR payments from within Xero. The invoice will be raised in 

Ostendo, then passed through to Xero AR where you later record the customer payment 

through the Bank Reconciliation screen or via the Customer Payment options directly from Xero. 

Ostendo then reads back the customer payment and updates the invoice in Ostendo and creates 

an updated customer payment. (no financial posting is generated in Ostendo with this type of 

payment as it has already occurred within Xero) 

 

This means that Ostendo AR ledger is constantly kept in sync with the Xero AR ledger.  

 

Customer Statements could be run from either Xero or Ostendo. 

 

As customers are added or maintained in Ostendo, those records are passed automatically with 

the posting process to Xero resulting in either new Contacts added, or existing Contact updated 

in Xero. 

 

Sales Credit Allocations: 

The API does not allow Ostendo receive Sales Credit Allocations to Invoices, therefore these 

must be manually processed in both systems in order to keep the AR Ledgers in sync. 

 

Credit Allocation in Xero = Customer Payment Style ‘Match Credits to Invoices in 

Ostendo. 

 

The process in both systems does not generate any financial entries. 
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Method 2 Explained: 
 

Uses both Xero and Ostendo Accounts Receivable Sub Ledgers 

 

This method allows you to manage AR primarily from Ostendo. The invoice will be raised in 

Ostendo, then passed through to Xero AR. However unlike Method 1, you would then process 

the customer payment from within Ostendo. This payment will then be passed through to Xero 

to update Xero’s AR ledger. 

 

Method 2 MUST be used if ‘ANY’ of these types of transactions originate from within Ostendo 

• Point Of Sale 

• Customer Payments 

• Customer Deposits 

 

This can also be used if an existing Ostendo site prefers to capture customer payments directly 

within Ostendo even if Ostendo POS or Customer Deposits are not used. 

 

The approach here is that customer payments are primarily maintained within Ostendo and are 

passed to Xero for Bank reconciliation purposes. Financial Postings are also passed through to 

Xero in this case.  

 

Customer Statements could be run from either Xero or Ostendo 

 

When you perform a bank reconciliation in Xero, instead of matching the payment to the Sales 

Invoice, you would be applying a Bank Rule to transfer the amount from a Bank Clearing 

account (Current Asset) to the Xero Bank account (Bank). This is because Xero does not allow 

Ostendo to post the Payment directly to the Xero Bank Account, therefore a clearing account is 

used to post to from Ostendo, leaving Xero to transfer this to Bank clearing at the point of 

reconciliation. 

 

As customers are added or maintained in Ostendo, those records are passed automatically with 

the posting process to Xero resulting in either new Contacts added, or existing Contact updated 

in Xero. 

 

Sales Credit Allocations: 

The API does not allow Ostendo receive Sales Credit Allocations to Invoices, therefore these 

must be manually processed in both systems in order to keep the AR Ledgers in sync. 

 

Credit Allocation in Xero = Customer Payment Style ‘Match Credits to Invoices in 

Ostendo. 

 

The process in both systems does not generate any financial entries. 
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Method 3 Explained: (NB: Available Late 2021) 

 
 

Uses only Ostendo AR Ledger 

 

This method should be used in high volume environments to minimise transaction volumes 

being passed to Xero. An example of a high volume site would be 500 sales and purchase 

invoices per day with an average number of lines being 20 or more.  

 

Sales and Payment transactions are posted to Xero in a summarised form and processed daily 

as one Manual GL Journal. This approach means your debtors ledger is solely controlled from 

Ostendo. The Xero AR sub ledger and Customer Contacts are not used. Xero will only report the 

total Debtors value at a Balance Sheet level, whilst Ostendo will provide the detail from its own 

sub-ledger reporting. 

 

This method adopts the approach that the AR ledger is solely maintained within Ostendo 

therefore Customer Statements can only be run from Ostendo. 

 

When you perform a bank reconciliation in Xero, instead of matching the payment to the Sales 

Invoice, you would be applying the previously created Bank Rule to transfer the amount from a 

Bank Clearing account to the Xero Bank account. 
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Base Integration Setup (All Methods) 
 

This process sets up the communication link between Ostendo and Xero using OAuth2 security 

and Xero’s API. This setup must be done first 

 

 

Preparation - Xero: 
 

Xero Invite 

Xero Login  

 

Your Xero login User permissions level must be at least STANDARD.  

 

Note: if this permission level is downgraded to anything lower than STANDARD, 

the integration between Ostendo and Xero will be disconnected. 

 

 

Preparation - Ostendo: 
 

Sales Rules 

Sales -> Settings -> Sales Rules 

Default Payment Method 
Default Payment Account 

 

These defaults (or those set against the actual Customer) are used when Payments are 

created in Ostendo.  

 

 
 

System Settings 

File -> System Configuration  

 

1) Accounting Link Style = Xero 

2) Set the Posting Frequency (Recommended 30 – 60 minutes. Large volume sites 

should be greater) 

3) Cutover Date = This controls whether financial entries will be posted to Xero 

based on their transaction date. 

4) Timeout = 120 mins Retry Count = 1 

5) AR Style : Select either:  

  Standard Invoice and Payments Posting (Methods 1 & 2) 

or Post Invoices and Payments as Journals (Method 3 only) 

6) Post all Foreign Currency transactions as Local Currency Ledger 

transactions:  

DO NOT TICK this if you wish to post foreign currency transactions as FOREIGN 

CURRENCY with accompanying exchange rates.  

 

Tick this if you wish to post all Foreign Currency transactions to Xero in your local 

currency for example if you are posting to a Xero ‘Standard’ version which does 

not have Multiple Currency capabilities. 
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NB: This applies to all Debtor AND Purchase Invoices processed in 

Ostendo 

 

7) Post Daily Summaries (Method 3 Only) – Only used if AR Style = “Post 

Invoices and Payments as Journals” is selected, then you can also select various 

transaction types of Daily Summaries by ticking the appropriate box in the list 

provided. NB: Journals will NOT be summarised If ‘Post Daily Summaries the 

Following Day (Step 10)’ is NOT ticked. 

8) External Accounts Receivable is automatically ticked for Xero (this cannot be 

overridden and is ignored by Ostendo when AR Style = Journals) 

9) Prevent Manual Payments Tick this when using Method 1. This prevents 

Ostendo users from entering Customer Payments as a Payment Style of ‘Received 

Payment’ 

10) Post Daily Summaries the Following Day - (Method 3 Only) This is used in 

conjunction with the Daily Summaries specified above in step 7 and will 

accumulate all relevant types of transactions specified above from being posted 

immediately and release the Summary batches to Xero the next day. (Used to 

reduce volumes posted to Xero) 

 

 
 

User Security and Settings User Option 

File -> System Configuration -> User Security & Options  

 

Ensure at least one Ostendo user has the No External GL Posting selected. 
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Posting of transactions to Xero is initiated when one or more Ostendo users (having “No 

External GL Posting” unticked) are logged in. 

 

 

 
 

 

Purchase Rules 

Purchasing -> Settings -> Purchase Rules 

 

Ensure you have “Default Freight Descriptor” and “Default Other Descriptor” set to 

handle Freight and Additional Charges entered on the Purchase Invoice screen. These 

descriptors can be mapped accordingly to post charges to relevant GL Accounts.  

 

 
 

 

Tax Codes 

File -> Financial Configuration -> Tax Codes 

 

• Ensure you have linked the appropriate External Tax Codes to the Ostendo Tax Codes. 

 

NB: The setup below is typical for NZ, however for Australia and other regions, different 

External Tax Codes are used.  

 

Please refer to http://developer.xero.com/documentation/api/types/#TaxTypes  

 

In Ostendo, ensure the Tax Codes / Groups and Matrix rules have been specified. 

 

Setup an appropriate Ostendo Tax Code with the Tax Rate %. Enter the appropriate Xero 

External Tax Code (Income) along with the External Purchase Tax Code (NB: These are 

case sensitive) 

 

This means that one Ostendo Tax Code can be set for both Sales and Purchases whilst 

Xero’s individual External Tax Codes will be used when the transactions are posted. 

 

 

http://developer.xero.com/documentation/api/types/#TaxTypes
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Ensure you have also setup up the Ostendo Tax Groups and Matrix. 

 

Xero relies on specific Tax Types in order to determine Input / Output Tax. You must 

specify these from the base country of your Xero database.  

 

Eg:  

    New Zealand 

TAX TYPE RATE NAME SYSTEM DEFINED 

INPUT2 15.00 GST on Expenses 
 

NONE 0.00 No GST Yes 

ZERORATED 0.00 Zero Rated 
 

OUTPUT2 15.00 GST on Income 
 

GSTONIMPORTS 0.00 GST on Imports Yes 

 

      Australia 

TAX TYPE RATE NAME SYSTEM DEFINED 

OUTPUT 10.00 GST on Income 
 

INPUT 10.00 GST on Expenses 
 

EXEMPTEXPENSES 0.00 GST Free Expenses Yes 

EXEMPTOUTPUT 0.00 GST Free Income 
 

BASEXCLUDED 0.00 BAS Excluded 
 

GSTONIMPORTS 0.00 GST on Imports Yes 

 

New Zealand: INPUT2  (15% GST on Exps) 

  OUTPUT2  (15% GST on Income) 

ZERORATED (Zero Rated on Income NB: Ensure the Ostendo 

External Purchase Tax Code is set to NONE) 

 

 

Australia OUTPUT  (10% GST on Exps) 

  INPUT   (10% GST on Income) 

ZERORATED (Zero Rated on Income NB: Ensure the Ostendo 

External Purchase Tax Code is set to NONE) 
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General Ledger Settings 

File -> Financial Configuration -> General Ledger Settings 

 

1. Ensure the Default = Xero (This is set initially from the System Settings 

Accounting Link Style) 

2. Press the Add button to create a GL settings record 

3. Use the Accounting Link drop down to select ‘Xero’ 

4. Tick the Debug Mode option. This will automatically create batch posting debug 

files for every batch in a Debug folder within the Ostendo folder. These can be 

useful for later diagnostic analysis if required 

5. Copy or type this URL into the URL Path field. https://api.xero.com/api.xro/2.0/ 

6. Ensure ‘Use OAuth1.0a (Depreciated) is Unticked. 

7. Press the Update Button to download the latest Ostendo Accounting Script. From 

this point on, Ostendo will automatically check for new versions of this script and 

load them when the first Ostendo user logs on each day. Once this has been run 

the Version will be displayed next to the Debug Mode field. 

8. Press the Setup button to begin the connection setup to Xero 

 

 
 

 

9. After the Setup button is pressed, your browser will be launched, and you will be 

directed to a Xero Log In screen.  

 
 

Type in the email address and password (must be the same account you were 

previously invited to from Xero) 

 

  

https://api.xero.com/api.xro/2.0/
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10. Select the organisation and press the ‘Allow Access’ button 

 

 
 

11. The above process will trigger Ostendo to pop up Information confirming access 

to the Xero organisation. Answer ‘Yes’ to this popup 

 

 
 

12. An Information box will popup confirming the connection details. Press OK to 

continue 

 
 

13. Finally, a confirmation Information box will popup confirming the connection is 

successful. Press OK to continue 
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14. A XeroTaxList.txt file will also be launched showing the Mapped External Tax 

Types and Codes in both systems. Confirm this information is correct. If not, 

correct in Ostendo Tax Codes and come back to the GL Settings screen and press 

the ‘Connect’ button to refresh and check. 

 

 
 

 

• Now the connection is complete you should import the GL Codes (and or Xero Tracking 

Categories) into Ostendo to enable Cost Centre to GL Account / Tracking Category 

Mapping. 

 

From the GL Settings screen press the Import button and select ‘GL Codes’ 

 

 
 

 

NB: Repeat this process if a new General Ledger Code or Tracking Category is 

added in Xero. 
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• Optional  

 

 

 

 

•  

Import button allows you to  

o (Method 1 or 2) Add new Ostendo Customers from existing Xero Customer 

Contacts 

o (Method 1 or 2) Update existing Ostendo Customers from existing Xero 

Customer Contacts 

o (All Methods) Add new Ostendo Suppliers from existing Xero Supplier Contacts 

o (All Methods) Update existing Ostendo Suppliers from existing Xero Supplier 

Contacts 

 

Export button allows you to  

o (Method 1 or 2) Add new Xero Customer Contacts from existing Ostendo 

Customers 

o (Method 1 or 2) Update existing Xero Customer Contacts from existing 

Ostendo Customers 

o (All Methods) Add new Xero Supplier Contacts from existing Ostendo Suppliers 

o (All Methods) Update existing Xero Supplier contacts from existing Ostendo 

Suppliers 

 

 

 

 

 

 

 

 

 

 

 

This completes the Base Integration Setup for all Methods 

  

NB: It is important to note that Ostendo uses the Customer or Supplier name 

to match in both systems. (All Names are Case Sensitive). New Customers or 

Suppliers must be added or maintained in Ostendo, thereby the posting 

process will automatically manage those changes in Xero.  

NB: Typically, this process is only used once if this is a new Ostendo or new 

Xero database where one of those databases contains Customers and / or 

Suppliers and the other does not. 



 

Copyright 2021 Development-X Ltd Revision 1.0.0 Page 16 

Method 1 Setup: 
 

Assuming you have now ensured all Customers and Suppliers exist in both Ostendo and Xero 

you can now introduce all outstanding Sales Invoices as at your Cut Over Date. This process can 

be done manually or by importing those transactions into the relevant database. 

 

Debtors Opening Balances: 

 

These invoices need to exist in both Ostendo and Xero and have exactly the same 

o Invoice Number 

o Invoice Date (no later than the Cut Over date) 

o Customer (Contact) Name 

o Outstanding Invoice Amount (inclusive of GST) 

 

 

 

 

 

 

 

 

 

 

 

 

This completes Method 1 setup, now refer to Cost Centre Mapping Section 

 

 

  

GST consideration when entering Opening Balances. 
(Refer to your Accountant if you are unsure) 
 
Cash Basis: 
Ensure the invoice lines contain the correct tax codes. 
 
Invoice (Accrual Basis): 
Each invoice line can have a No Tax (not Zero Rated) type code 
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Method 2 Setup: 
 

Assuming you have now ensured all Customers and Suppliers exist in both Ostendo and Xero 

you can now introduce all outstanding Sales Invoices as at your Cut Over Date. This process can 

be done manually or by importing those transactions into the relevant database. 

 

Debtors Opening Balances: 

 

These invoices need to exist in both Ostendo and Xero and have exactly the same 

o Invoice Number 

o Invoice Date (no later than the Cut Overdate) 

o Customer (Contact) Name 

o Outstanding Invoice Amount (inclusive of GST) 

 

 

 

 

 

 

 

 

 

 

 

 

 

Xero Bank Clearing Account: 

 

Because Xero does not allow us to post directly to a Bank account, we must post the 

Bank entries to a Xero General Ledger account called ‘Ostendo Bank Clearing’. (This is an 

account type in Xero of ‘Current Asset’, rather than that of a Bank Account.). A Bank 

Rule must be setup in Xero in order to automatically allow a transfer between this 

account and the actual bank account to enable the bank reconciliation in Xero to be 

completed. 

 

It is important to note that a good knowledge of Xero is required for this, therefore we 

suggest you work with your Accountant.  

 

1. Account Type = Current Asset 

2. Tax = No GST 

3. Tick ‘Enable payments to the account’ 

  

 
 

GST consideration when entering Opening Balances. 
(Refer to your Accountant if you are unsure) 
 
Cash Basis: 
Ensure the invoice lines contain the correct tax codes. 
 
Invoice (Accrual Basis): 
Each invoice line can have a No Tax (not Zero Rated) type code 
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Xero Bank Clearing Bank Rule 

 

Setup a Bank Rule in Xero to allow the Payment amount to be transferred from 

Ostendo Bank Clearing to the Bank Account 

 

1. Ensure this is a ‘Receive Money Rule’ 

2. Set to match ‘All’ conditions when Amount is greater than Zero 

3. Set to ‘the Payee from the bank’ 

4. Set the following: 

▪ Description – Transfer From Ostendo Bank Clearing 

▪ Account – Ostendo Bank Clearing 

▪ Tax Rate – No GST 

▪ Percent – 100% 

5. The reference will be set ‘from the Reference’ 

6. Target Bank Account – All or nominated 

7. Title – Ostendo Bank Clearing 

 

 
 

 

This completes Method 2 setup, now refer to Cost Centre Mapping Section 
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Method 3 Setup: 
 

Xero Bank Clearing Account: 

 

Because Xero does not allow us to post directly to a Bank account, we must post the 

Bank entries to a Xero General Ledger account called ‘Ostendo Bank Clearing’. (This is an 

account type in Xero of ‘Current Asset’, rather than that of a Bank Account.). Then 

bank rules must be setup in Xero in order to automatically create a transfer between this 

account and the actual bank account to enable the bank reconciliation in Xero to be 

completed. 

 

It is important to note that a good knowledge of Xero is required for this, therefore we 

suggest you work with your Accountant.  

 

From the Chart Of Accounts within Xero, setup the following GL Account:  

 

1. Account Type = Current Asset 

2. Tax = No GST 

3. Tick ‘Enable payments to the account’ 
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Xero Bank Clearing Bank Rule 

 

Setup a Bank Rule in Xero to allow the Payment amount to be transferred from 

Ostendo Bank Clearing to the Bank Account 

 

1. Ensure this is a ‘Receive Money Rule’ 

2. Set to match ‘All’ conditions when Amount is greater than Zero 

3. Set to ‘the Payee from the bank’ 

4. Set the following: 

▪ Description – Transfer From Ostendo Bank Clearing 

▪ Account – Ostendo Bank Clearing 

▪ Tax Rate – No GST 

▪ Percent – 100% 

5. The reference will be set ‘from the Reference’ 

6. Target Bank Account – All or nominated 

7. Title – Ostendo Bank Clearing 
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Ostendo Trade Debtors GL Account 

 

From the Chart Of Accounts within Xero, setup the following GL Account: 

 

1. Account Type – Current Asset 

2. Name – Ostendo Trade Debtors 

3. Tax – No GST 

 

 
 

 

Debtors Opening Balances 

 

As this method does not use the Xero Debtors AR Ledger, there is no need to enter any 

individual outstanding invoices as at Cut Over date, however a Xero Manual GL Journal 

will be required to populate the Ostendo Trade Debtors GL account with the total 

outstanding balances as at the Cut Over date. 

 

Exchange Rate Gain or Loss 

 

• If Multi Currency transactions are in use in Ostendo, you will also need to create an 

Expense Account in Xero called “Ostendo Exchange Rate Gain or Loss”. 

 

 

 

This completes Method 3 setup, now refer to Cost Centre Mapping Section 
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Cost Centre Mapping 
 

Overview: 
 

Each time a financial transaction is generated within Ostendo, an Ostendo financial 

record will be created with both Debit and Credit amounts. Ostendo uses Cost Centres to 

record these against. Simply put, think of a Cost Centre as a General Ledger code. In 

Ostendo, we simply map (link) the Ostendo Cost Centre Code to its Xero counterpart GL 

Code. Therefore, within Ostendo whilst we use these Cost Centre codes for reporting etc, 

we also use the linked GL accounts to each Cost Centre to create the financial 

transaction into Xero.  

 

Ostendo Cost Centres also record Xero Tracking Categories if used. When Ostendo 

creates the financial transaction to Xero, these are included at the same time. 

 

This next process describes how to link the Cost Centres to the GL and Tracking 

Categories together. 

 

Before any mapping proceeds, it is essential that your Accountant is involved in this 

process to ensure the appropriate GL accounts are linked. 

 

Cost Centre Mapping Ostendo Cost Centres To Xero GL  
 

General -> Cost Centres 

 

Select the Cost Centre Code and proceed to the Detail Screen 

 

 
 

From the Detail screen 

1. Browse and select the appropriate Xero GL Code 

2. Browse and select the appropriate Xero Tracking Category (if required). 

 

 
 

 



 

Copyright 2021 Development-X Ltd Revision 1.0.0 Page 23 

 

 

 

 

 

 

 

Information To Note about Mapping and Methods 
 

 

 

Method 1 Cost Centre Mapping for Bank 
 

As you will not be processing any Customer Payments directly from within Ostendo, you 

can leave the Cost Centre ‘BANK’ unmapped. Payments read back from Xero will not 

create any financial postings in Ostendo. 

 

 

Method 2 & 3 Cost Centre Mapping for Bank 
 

Ensure you map the Ostendo Bank Cost Centre(s) to the Xero GL Account named 

‘Ostendo Bank Clearing’ (Not the Std Xero Bank Account)  

 

 

Method 3 only  Cost Centre Mapping for Debtors 
 

Ensure you map the Ostendo Cost Centre ‘DEBTORS to the Xero GL Account named 

‘Ostendo Trade Debtors’ (Not the Std Xero Accounts Receivable GL Account) 

 

 

Methods 2 & 3 Cost Centre Mapping for Exchange Loss or Gain 
 

If Multi Currency transactions are in use in Ostendo you will need to create an 

Expense Account in Xero called “Ostendo Exchange Rate Gain or Loss” and map the 

Exchange Rate Gain or Loss Cost centre in Ostendo to this. NB: You must not map this 

cost centre to the standard Xero Exchange Rate Gain or Loss GL account, as the Xero 

API prevents postings to this account 

 

  

Hint: If you are missing a GL code or need to setup or amend a Xero Code, 

ensure you return to the Ostendo GL Settings screen and re-import GL 

Codes. This will update the GL Code and Tracking Categories in Ostendo 
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Ostendo Cost Centres Defined 
 

Ostendo uses the concept of Cost Centres to record costs from all areas of the product.  There 

are Base and User Defined Cost Centres and are directly linked to a Xero General Ledger 

Account Codes and if required, to a Xero Tracking Category 

  

Base Cost Centres 
  

Ostendo comes with ‘Base Level’ settings in which pre-defined Cost Centres are ready to be 

mapped to Xero GL Account Codes 

  

Cost Centre Groups  

 

General ->Settings ->Cost Groups 

  

Cost Centres can be grouped into logical areas.  These relate to the Cost Areas such as  

• Asset 

• Liability 

• Income 

• Expense 

• Cost of Sale 

• Bank 

• etc 

  

  

Cost Centre Maintenance  
 

General ->Cost Centres 

  

This screen shows all Base and User Defined Cost Centres.  In the absence of any changes 

these Cost Centres will be used when integrating with Xero.   

  

Base Cost Centre Mapping 

 

File ->Financial Configuration ->Cost Centre Mapping 

  

The above Base Cost Centres are linked to areas where costs are stored.  Out-of-the-Box 

Ostendo contains a list of pre-defined areas and their associated Cost Centres. Typically, these 

mappings do not need to be amended.  

  

The pre-defined areas are: 

  

Stock: All Stock across all Warehouses and Locations in your Company’s Inventory is kept 

against this Cost Centre.  If a Warehouse is allocated a specific Cost Centre then that will be 

used in preference to this default. 

  

Stock Adjustment Variance: Stock Adjustments are ‘received from’ or ‘issued to’ a Cost 

Centre.  This Cost Centre provides a global place for ‘posting’ the Costs from this function 

  

Negative Adjustment Variance: Stock adjustment variances can occur whenever you receive 

Stock but the current stock levels are negative.  In this case the Average Cost for the Item is 

not amended but the difference between the Average Cost and the Cost of this receipt is 

‘posted’ to this Cost Centre 

  

Revaluation of Stock Variance: Whenever the Stock is re-valued  (Standard Cost or Average 

Cost) the difference between the old value and the new value is ‘posted’ to this Cost Centre 
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Stock Count Variance: Stock variances (plus or minus) as a result of a Stock Count are 

‘posted’ to this Cost Centre.   

  

Stock In Transit: Whenever Stock is moved from one Warehouse to another via the Inventory 

Transfer routine this Cost Centre will be used for that transfer. 

  

Receipt Cost Var: Used if the Inventory Costing method is ‘Standard Costing’.  In that instance 

this stores the cost difference between the Assembly Order actual Cost and the Standard Cost 

of the Item. 

  

Descriptor Expenses: This is the default Cost Centre used by Descriptors.  It can be amended 

at Descriptor level to another Cost Centre and made specific to that Descriptor.   This Cost 

Centre is then used as the ‘allocated’ Cost Centre during Purchase Receipts. 

  

Catalogue Expenses: This is the default Cost Centre used by Supplier Catalogue Items.  This 

Cost Centre is used as the ‘allocated’ Cost Centre during Purchase Receipts.  If a Supplier 

Catalogue is allocated a specific Cost Centre then that will be used in preference to this default. 

  

Warranty Costs: Where a Job Issue has it’s ‘Actual Issue’ allocated to a Charge Style of 

‘Warranty’ then the costs are ‘posted’ to this Cost Centre 

  

Contract Costs: Where a Job Issue has it’s ‘Actual Issue’ allocated to a Charge Style of 

‘Contract’ then the costs are ‘posted’ to this Cost Centre 

  

Direct Labour Costs: When an Employee Timesheet Transaction is made then the costs are 

‘posted’ to this Cost Centre 

  

Fixed Labour Overhead Costs: When an Employee Timesheet Transaction is made then the 

associated FOH costs - held against the linked Labour Code - are ‘posted’ to this Cost Centre 

  

Variable Labour Overhead Costs: When an Employee Timesheet Transaction is made then 

the associated VOH costs - held against the linked Labour Code - are ‘posted’ to this Cost 

Centre 

  

Purchases Received Not Invoiced: For any Purchase Orders that have been received via the 

‘Purchase Order Receipts’ function are held in this Cost Centre until they have been ‘matched’ in 

the ‘Purchase Order Invoicing’ screen  

  

Purchase Price Variance: Purchase Orders received via the ‘Purchase Order Receipts’ function 

contain a Purchase Price and this is ‘posted’ at that time.  When it is matched against the 

‘Purchase Order Invoicing’ there may be a Price difference.  This difference is posted to this Cost 

Centre.   

  

Creditors: Whenever a Purchase Invoice is received then the amount of that Invoice is ‘posted’ 

to this Cost Centre.   

  

Assembly Work In Progress: For any Issues (Material, Labour, Descriptors, etc) that have 

been issued to Work In Progress for an Assembly Order the cost of that issue is ‘posted’ to this 

Cost Centre.  Note: The cost of the Assembly Order is taken out of this Cost Centre whenever 

the Assembly Order is received into Inventory 

  

Assembly Order Variance: If the Assembly Order has been completed and its status is 

‘Closed’ then any subsequent Issues or Bookings to this Order will go direct to this Cost Centre 

rather than the Assembly Work In Progress Cost Centre. 

  

Job Work In Progress: For any Issues (Material, Labour, Descriptors, etc) that have been 

issued to Work In Progress for a Job Order the cost of that issue is ‘posted’ to this Cost 

Centre.  Note: The cost of the Job Order is taken out of this Cost Centre whenever the Job 

Order is Invoiced. 
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Job Cost Of Goods Sold: Any Invoice raised against the Job Order will take the cost of the 

Invoice out of the ‘Job Work In Progress’ Cost Centre and add it to this Cost Centre. 

  

Job Cost Variance: If the Job Order is ‘Closed’ then any subsequent Issues or Bookings to this 

Order will go direct to this Cost Centre rather than the Job Work In Progress Cost Centre.  

  

Job Income: Any Income received that has been applied to a Job Invoice Line will be ‘posted’ 

to this Cost Centre.   

  

Sales Lines Picked: Whenever a Sales Order Line is ‘Picked’ the cost of that line is moved from 

the source Cost Centre (Example: ‘Stock’ Cost Centre for Inventory Items) and moved to this 

Cost Centre. 

  

Sales Cost Of Goods Sold: Whenever a Sales Order Line is ‘Invoiced’ the cost of that line is 

moved from the ‘Sales Line Picked’ Cost Centre to this Cost Centre. 

  

Sales Income: Any Income received that has been applied to a Sales Invoice Line will be 

‘posted’ to this Cost Centre.   

  

Freight: Any Income received that covers Freight and has been applied to an Invoice will be 

‘posted’ to this Cost Centre.   

  

Debtors: Whenever an Invoice (or credit) is raised then the amount of that Invoice is ‘posted’ 

to this Cost Centre.  Whenever a Deposit or Payments is matched to an Invoice then it is moved 

from this Cost Centre to the above Sales Invoice, Sales Freight, and Sales tax Cost Centres. 

  

Contract Income: Any Income received that has been applied to a Contract Invoice Line will 

be ‘posted’ to this Cost Centre.  Until it is ‘posted’ the income will reside in the ‘Unapplied 

Deposits’ or ‘Unapplied Payments’ Cost Centres 

  

Deferred Cost Of Goods: The value of any Retention amount raised against a Job Order 

Invoice will take the cost of the Retention out of the ‘Job Work In Progress’ Cost Centre and add 

it to this Cost Centre. 

  

Deferred Income: This is only used in ‘Progress Claim’ environments that have an Invoicing 

Schedule where the specific scheduled Invoice has an Accounting Style of ‘Income Deferred’. 

This provides facility to have this type of Income deferred for future P & L recognition. 

  

Deferred Freight: This is only used in ‘Progress Claim’ environments that have an Invoicing 

Schedule where the specific scheduled Invoice has an Accounting Style of ‘Income Deferred’. 

This provides facility to have this type of Freight deferred for future P & L recognition 

  

Deferred Tax: This is only used in ‘Progress Claim’ environments that have an Invoicing 

Schedule where the specific scheduled Invoice has an Accounting Style of ‘Income Deferred’. 

This provides facility to have this type of Tax deferred for future P & L recognition 

  

Un-Applied Deposits: (Methods 2 & 3 only) Deposits received from a Customer will be 

‘posted’ to this Cost Centre.  When they are applied to an Invoice they will be moved to the 

‘Sales Income’ Cost Centre 

  

Un-Applied Payments: (Methods 2 & 3 only) Payments received from a Customer will be 

‘posted’ to this Cost Centre.  When they are applied to an Invoice they will be moved to the 

‘Sales Income’ Cost Centre 

  

Bank: (Methods 2 & 3 only) Upon validation that the Payment was banked (Deposit Slip 

status updated to ‘Banked’ then the amount is transferred from the ‘Un-deposited Funds’ Cost 

Centre and ‘posted’ to this Cost Centre 
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Payment Rounding: (Methods 2 & 3 only) If the ‘matched’ payment amount is within a 

‘Rounding Tolerance’ entered in that screen then the Payment record status is amended to ‘Fully 

Applied’.  The actual value of the Rounded amount is ‘posted’ to this Cost Centre,  

  

Discounts Given: (Methods 2 & 3 only) If a Discount Amount is entered during Payment 

Matching (Example: ‘Prompt Payment’ discount) then the value of this discount is ‘posted’ to 

this Cost Centre. 

  

Undeposited Funds:  (Methods 2 & 3 only) Whenever a Bank Deposit Slip is raised (Status 

is ‘Pending’) the included payments are ‘posted’ to this Cost Centre.   

  

POS End of Day Variance: Whenever a 'Z' Report is printed from the End Of Day processing in 

the Point of Sales function than if the Till Balance is at variance to the expected balance then 

the difference is posted to this Cost Centre   

  

POS Shop Expenses: Whenever a Cash withdrawal or deposit is made within the POS function 

then the amount Withdrawn/Deposited is held in this Cost Centre 

 

Exchange Loss or Gain: (Methods 2 & 3 only when Multi Currency in use but being 

converted into Local Currency) Ostendo will calculate the appropriate FX Gain or Loss at the 

point of processing the Customer Payment. This is the difference between the Invoice Exchange 

Rate Vs the Payment Exchange Rate 

 

Assembly Cost Var: If you are using Standard Costing then the difference between the 

Standard Cost of the Receipt and the actual WIP Cost of the Item is posted to this Cost Centre 

 

Payment Charge: (Methods 2 & 3 only) If a Customer Payment is recorded with a Payment 

Charge (eg: Credit Card Charge) you are able to post this charge to this specific Cost Centre 
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Points of Integration: 
 

 

There are many Xero API resources available. However not all resources are part of the 

Ostendo – Xero integration. The affected resources are as follows: 

 

 

Contacts - this is the Xero resource which holds Supplier and Customer information. 

Any addition or change in Supplier/Customer master records in Ostendo will be 

reflected in Xero except ‘InActive’ records. 

 

Xero API does not allow for posting of ContactStatus = DELETED. This means that 

InActive Suppliers or Customers in Ostendo need to be manually set as DELETED in 

Xero.  

 

The IsSupplier Boolean value cannot be set via Xero API – it is automatically set when 

an accounts payable invoice is generated against the contact. This means Suppliers 

exported from Ostendo into Xero will initially have the IsSupplier set to “false”. 

 

The IsCustomer Boolean value cannot be set via Xero API – it is automatically set when 

an accounts receivable invoice is generated against the contact. This means Customers 

exported from Ostendo into Xero will initially have the IsCustomer set to “false”. 

 

 

Manual Journals – all journals except Invoice Payment and Invoice Deposit, 

are posted to this resource in Xero. 

 

 

 

 

 

 

 

Invoices – this resource caters to both Sales Invoices (Type= ACCREC) and 

Purchase Invoices (Type= ACCPAY). Sales Invoice transactions and Purchase Invoice 

transactions are posted to Xero as AUTHORISED invoice transactions. 

 

If AR Style “Post Invoices and Payments as Journals” is selected, then sales 

invoices and payments will be posted as manual journals to Xero. 

 

Credit Notes - this resource caters to both Sales Credit Notes (Type= 

ACCRECCREDIT) and Purchase Credit Notes (Type= ACCPAYCREDIT). Credit Notes 

are posted to Xero as AUTHORISED credit note transactions. 

 

Payments – Invoice Payment and Invoice Deposit journals are posted to Payments 

resource in Xero. Only the Debit side of the journal is posted. 
 

 

Note: Payment Discounts are posted to Xero as Credit Notes and applied to the 

associated Invoices. 

 

Customer Payments entered directly into Xero (if “No External Payments 

Returned” is not ticked in System Settings) will be pulled back into Ostendo and 

Customer Payment records will be created for the matching invoices. However no 

There are a few accounts that you can’t use when entering manual journals in Xero. 

These include system accounts (accounts receivable, accounts payable, retained 

earnings and Realised Currency Gains) and bank accounts. You will receive a 400 

validation error if you try and use these reserved accounts. 
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financial transactions will be created in Ostendo for such records – to avoid reposting 

back into Xero again. Such payment records in Ostendo will be marked as “External 

Payments”. 

 

Any such Payments entered in Xero which are subsequently deleted in Xero will also 

trigger the deletion of the matching “External Payment” from Ostendo’s  

CustomerPayments table. 

 

Note: Deletion of Payments can be done only from Xero – regardless of whether the 

payment was first entered in Ostendo or in Xero. When a payment is deleted in Xero, the 

accountinglink will check for deleted payments (during the next batch processing) and 

delete the corresponding payment in Ostendo. 

 

Over-Payments & Pre-Payments - When Over-Payments or Pre-Payments are 

created in Xero, these will generate Payments in Ostendo marked as ‘External’.  

 

Any allocations to sales invoices in Xero will be brought into Ostendo and applied to the 

corresponding invoices.  
 
Any Refunds of overpayment/prepayment in Xero will be brought into Ostendo to reduce 
the PAYMENTAMOUNT in CUSTOMERPAYMENTS record accordingly. 
 
Please note that Over-Payments/Pre-payments created in Xero can only be allocated to 
invoices from within Xero. 

 
 

 

Sales Credit Allocations (Methods 1 & 2) 
 

The API does not allow Ostendo receive Sales Credit Allocations to Invoices, therefore 

these must be manually processed in both systems in order to keep the AR Ledgers in 

sync. 

 

Credit Allocation in Xero = Customer Payment Style ‘Match Credits to Invoices 

in Ostendo. 

 

The process in both systems does not generate any financial entries. 
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All financial transactions generated in Ostendo will be summarised into the following tables: 

 

JOURNALHEADER– updates Manual Journals or Payments in Xero  

 

JOURNALLINES – updates Manual Journals or Payments in Xero 

 

JOURNALINVHEADER – updates Invoices or Credit Notes in Xero  

 

JOURNALINVLINES – updates Invoices or Credit Notes in Xero 

 

Changes to Customer Master and Supplier Master record will create transactions in 

FINANCIALCUSTOMERS and FINANCIALSUPPLIERS tables respectively. 

 

You can see a more detailed mapping of fields between Ostendo tables and Xero resources in 

Appendix A. 
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The Automated Posting Process: 
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As transaction records are added to the tables listed above, Ostendo will flag them as “Ready 

to Send”. Ostendo will post transactions to Xero based on the frequency set in System 

Settings. The frequency of posting can be set to in terms of minutes or hours.  

 

All transactions which are “Ready to Send” will be assigned a batch number and posted as 

one batch in the following order: 

 

FINANCIALSUPPLIERS transactions to Xero Contacts, 

 

FINANCIALCUSTOMERS transactions to Xero Contacts, 

 

JOURNALHEADER and LINES transactions (except Invoice Payments and Invoice Deposits) to 

Xero 

Manual journals 

 

JOURNALINVHEADER and LINES transactions to Xero Invoices and Credit Notes 

 

JOURNALHEADER and LINES for Invoice Payments and Invoice Deposits to Xero Payments. 

 

This process runs automatically in the background when there is at least one user logged in. 

 

This process can be prevented if the “No External GL Posting” flag is ticked for ALL users of 

the system. This flag is found in File->System Configuration->User Security & Options->User 

Options tab. 

 

 

 

User intervention is only required if there are failed batches occurring – which is indicated 

in the top status bar of the Ostendo main screen: 

 

 
 

 

 

If you click on the failed batches in the status bar, you will get the following: 

 

 
 

Click on “Display All batches that Failed” button and you will see a list of 

failed batches. Click on the Detail tab, and you will see the invalid 

transactions: 

 



 

Copyright 2021 Development-X Ltd Revision 1.0.0 Page 33 

 
 

Reviewing and correcting Failed Batches: 

 

The following GENERAL Inquiries are available to review the batches and transactions: 

 

-     Inquiry – Ledger Journals 

-     Inquiry – Ledger Sales Invoices 

-     Inquiry – Ledger Purchase Invoices 

 

Example of Ledger Journal inquiry – detail screen: 

 

 
 

Common causes of failed batches include: 

• Incorrect tax codes used (Tax code mapping not completed correctly). 

• Ledger Account in Xero was not set to accept payments. 

• Missing Account Codes (Cost Centre – Ledger Codes mapping incorrect or incomplete) 

• The document date cannot be before the period lock date (Attempting to post a 

transactions to Xero dated in a closed period) 

 

Once the errors are fixed, the batches can be re-posted by clicking on the Repost Batch and 

Process Batches buttons. 
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Appendix A: (Ostendo-Xero Data Mapping) 
 

Suppliers 
 

OSTENDO Xero 

Table FieldName Fieldname Resource 
FINANCIALSUPPLIERS Supplier Name Contacts 

  IsSupplier (= true) Contacts 
  ContactStatus (= Active) Contacts 
FINANCIALSUPPLIERS SupplierWeb Website Contacts 
FINANCIALSUPPLIERS SupplierEmail EmailAddress Contacts 
FINANCIALSUPPLIERS CurrencyCode DefaultCurrency Contacts 
    

  AddressType (POBOX) Contacts 
FINANCIALSUPPLIERS SupplierAddress1 AddressLine1 Contacts 
FINANCIALSUPPLIERS SupplierAddress2 AddressLine2 Contacts 
FINANCIALSUPPLIERS SupplierAddress3 AddressLine3 Contacts 
FINANCIALSUPPLIERS SupplierCity City Contacts 
FINANCIALSUPPLIERS SupplierState Region Contacts 
FINANCIALSUPPLIERS SupplierPostalCode PostalCode Contacts 
FINANCIALSUPPLIERS SupplierCountry Country Contacts 
FINANCIALSUPPLIERS PrimaryContact AttentionTo Contacts 
    

  AddressType (STREET) Contacts 

FINANCIALSUPPLIERS PhysicalAddress1 AddressLine1 Contacts 
FINANCIALSUPPLIERS PhysicalAddress2 AddressLine2 Contacts 
FINANCIALSUPPLIERS PhysicalAddress3 AddressLine3 Contacts 
FINANCIALSUPPLIERS PhysicalCity City Contacts 
FINANCIALSUPPLIERS PhysicalState Region Contacts 
FINANCIALSUPPLIERS PhysicalPostalCode PostalCode Contacts 
FINANCIALSUPPLIERS PhysicalCountry Country Contacts 
FINANCIALSUPPLIERS PrimaryContact AttentionTo Contacts 
    
  PhoneType (FAX) Contacts 
FINANCIALSUPPLIERS SupplierFax PhoneNumber Contacts 
  PhoneType (MOBILE) Contacts 
FINANCIALSUPPLIERS SupplierMobile PhoneNumber Contacts 
  PhoneType (DEFAULT) Contacts 
FINANCIALSUPPLIERS SupplierPhone PhoneNumber Contacts 
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Customers 
 

OSTENDO Xero 

Table FieldName Fieldname Resource 
FINANCIALCUSTOMERS Customer Name Contacts 

  IsCustomer (= true) Contacts 
  ContactStatus (= Active) Contacts 
FINANCIALCUSTOMERS CustomerWeb Website Contacts 
FINANCIALCUSTOMERS CustomerEmail EmailAddress Contacts 
FINANCIALCUSTOMERS CurrencyCode DefaultCurrency Contacts 
    

  AddressType (POBOX) Contacts 
FINANCIALCUSTOMERS CustomerAddress1 AddressLine1 Contacts 
FINANCIALCUSTOMERS CustomerAddress2 AddressLine2 Contacts 
FINANCIALCUSTOMERS CustomerAddress3 AddressLine3 Contacts 
FINANCIALCUSTOMERS CustomerCity City Contacts 
FINANCIALCUSTOMERS CustomerState Region Contacts 
FINANCIALCUSTOMERS CustomerPostalCode PostalCode Contacts 
FINANCIALCUSTOMERS CustomerCountry Country Contacts 
FINANCIALCUSTOMERS PrimaryContact AttentionTo Contacts 
    

  AddressType (STREET) Contacts 

FINANCIALCUSTOMERS DeliveryAddress1 AddressLine1 Contacts 
FINANCIALCUSTOMERS DeliveryAddress2 AddressLine2 Contacts 
FINANCIALCUSTOMERS DeliveryAddress3 AddressLine3 Contacts 
FINANCIALCUSTOMERS DeliveryCity City Contacts 
FINANCIALCUSTOMERS DeliveryState Region Contacts 
FINANCIALCUSTOMERS DeliveryPostalCode PostalCode Contacts 
FINANCIALCUSTOMERS DeliveryCountry Country Contacts 
FINANCIALCUSTOMERS PrimaryContact AttentionTo Contacts 
    
  PhoneType (FAX) Contacts 
FINANCIALCUSTOMERS CustomerFax PhoneNumber Contacts 
  PhoneType (MOBILE) Contacts 
FINANCIALCUSTOMERS CustomerMobile PhoneNumber Contacts 
  PhoneType (DEFAULT) Contacts 
FINANCIALCUSTOMERS CustomerPhone PhoneNumber Contacts 
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JOURNALS (except Invoice Payments and Invoice Deposits) 
 

OSTENDO Xero 

Table FieldName Fieldname Resource 
JOURNALHEADER JournalDescription Narration ManualJournals 

JOURNALHEADER JournalDate Date ManualJournals 
  Status (= POSTED) ManualJournals 
    

  JournalLine: ManualJournals 

JOURNALLINES LineDescription Description ManualJournals 
JOURNALLINES LedgerCode AccountCode ManualJournals 
JOURNALLINES ExternalTaxCode TaxType ManualJournals 
JOURNALLINES DebitValue / CreditValue LineAmount ManualJournals 
JOURNALLINES FINANCIALCATEGORY Tracking Category ManualJournals 
JOURNALLINES FINANCIALCATEGORY Tracking Option ManualJournals 
    
 

 

Journals - Invoice Payment and Invoice Deposit  
 

OSTENDO Xero 

Table FieldName Fieldname Resource 
  Invoice Payments 

JOURNALHEADER ReferenceNumber InvoiceNumber Payments 
  Account Payments 

JOURNALLINES LedgerCode Code Payments 
JOURNALHEADER JournalDate Date Payments 
JOURNALLINES ExchangeRate CurrencyRate Payments 
JOURNALLINES DebitValue Amount Payments 
JOURNALHEADER JournalID [JournalNumber] Reference Payments 
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Invoices  
 

OSTENDO Xero 

Table FieldName Fieldname Resource 
JOURNALINVHEADER InvoiceNettTotal > 0 Invoice Invoices 

JOURNALINVHEADER InvoiceType (Purchase) Type (= ACCPAY) Invoices 
JOURNALINVHEADER InvoiceNumber (CompanyInvnumber) InvoiceNumber Invoices 
    
JOURNALINVHEADER InvoiceType (Sales) Type (= ACCREC) Invoices 
JOURNALINVHEADER InvoiceNumber InvoiceNumber Invoices 
JOURNALINVHEADER InvoiceReference Reference Invoices 
    
JOURNALINVHEADER InvoiceDueDate DueDate Invoices 
JOURNALINVHEADER InvoiceNettTotal SubTotal Invoices 
JOURNALINVHEADER InvoiceTaxTotal TotalTax Invoices 
JOURNALINVHEADER InvoiceTotal Total Invoices 
    

  Contact Invoices 

JOURNALINVHEADER CompanyName Name Invoices 
JOURNALINVHEADER InvoiceDate Date Invoices 
  Status (AUTHORISED) Invoices 

  LineAmountTypes (Exclusive) Invoices 

JOURNALINVHEADER CurrencyCode CurrencyCode Invoices 
JOURNALINVHEADER Exchangerate CurrencyRate Invoices 
    

  LineItem Invoices 

JOURNALINVLINES ExternalTaxCode TaxType Invoices 
JOURNALINVHEADER, 
JOURNALINVLINES 

ExchangeRate,InvoiceQty, LineCode, 
LineDescription 

Description Invoices 

  Quantity (= 1) Invoices 

JOURNALINVLINES DebitLedgerCode / CreditLedgerCode AccountCode Invoices 
JOURNALINVLINES ExtendedNettPrice LineAmount Invoices 
JOURNALINVLINES ExtendedTax TaxAmount Invoices 
JOURNALINVLINES FINANCIALCATEGORY Tracking Category Invoices 
JOURNALINVLINES FINANCIALCATEGORY Tracking Option Invoices 
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Credit Notes  
 

OSTENDO Xero 

Table FieldName Fieldname Resource 
JOURNALINVHEADER InvoiceNettTotal < 0 CreditNote CreditNotes 

JOURNALINVHEADER InvoiceType (Purchase) Type (= ACCPAYCREDIT) CreditNotes 
JOURNALINVHEADER InvoiceNumber (CompanyInvnumber) CreditNoteNumber CreditNotes 
JOURNALINVHEADER InvoiceReference Reference CreditNotes 
    
JOURNALINVHEADER InvoiceType (Sales) Type (= ACCRECCREDIT) CreditNotes 
JOURNALINVHEADER InvoiceNumber CreditNoteNumber CreditNotes 
JOURNALINVHEADER InvoiceReference Reference CreditNotes 
    
JOURNALINVHEADER InvoiceDueDate FullyPaidOnDate CreditNotes 
JOURNALINVHEADER InvoiceNettTotal SubTotal CreditNotes 
JOURNALINVHEADER InvoiceTaxTotal TotalTax CreditNotes 
JOURNALINVHEADER InvoiceTotal Total CreditNotes 
    

  Contact CreditNotes 

JOURNALINVHEADER CompanyName Name CreditNotes 
JOURNALINVHEADER InvoiceDate Date CreditNotes 
  Status (AUTHORISED) CreditNotes 

  LineAmountTypes (Exclusive) CreditNotes 

JOURNALINVHEADER CurrencyCode CurrencyCode CreditNotes 
JOURNALINVHEADER Exchangerate CurrencyRate CreditNotes 
    

  LineItem CreditNotes 

JOURNALINVLINES ExternalTaxCode TaxType CreditNotes 
JOURNALINVHEADER, 
JOURNALINVLINES 

ExchangeRate,InvoiceQty, LineCode, 
LineDescription 

Description CreditNotes 

  Quantity (= 1) CreditNotes 

JOURNALINVLINES DebitLedgerCode / CreditLedgerCode AccountCode CreditNotes 
JOURNALINVLINES ExtendedNettPrice (-) LineAmount CreditNotes 
JOURNALINVLINES ExtendedTax (-) TaxAmount CreditNotes 
    
 


